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Civil 2020

1. Maximum Number Limit of Erection Load Cases for Construction Stage Analysis

« Maximum limit in the number of erection load cases is increased from 5 to 10.

Civil 2020 (v1.1) Release Note

- More erection loads can be applied during construction stage and the results can be viewed with different erection load cases and hence different load factors in the load combination.

= Analysis > Analysis Control > Construction Stage

Construction Stage Analysis Control Data

Analysis Option

Final Stage
(®) Last Stage (") Other Stage
[Jrestart Construction Stage Analysis Select Stages for Restart...

Analysis type Linear Analysis ~ MNonlinear Analysis Cantrol

() Independent Stage (®) Accumulative Stage

Indude Equilibrium Element Modal Forces

[indude P-Delta Effect P-Delta Analysis Control

Indude Time Dependent Effect Time Dependent Effect Control
Load Cases to be Distinguished from Dead Load for C.5. Qutput

Mo Load Case Name Type Casel s
3 Erection Load 8 oW LCa 5
g Erection Load 9 Dw LC9 Ll
10 Erection Load 10 Dw LC10 v | | Delete
< >

Cable-Pretension Force Contral

{®) Internal Force () External Force Add

Initial Farce Control

Replace

[]convert Final Stage Member F
Truss

[ change Cable Element to Equiv
(1 Apply Initial Member Force to G

Initial Tangel

All
Lack-of-Fit Forc
] Apply Camber Displa

D Consider Stress Decrease at Le
Linear Interpolation

Beam Section Property Changes
O Constant @

Frame Qutput

[ calculate Concurrent Forces of

Calculate Output of Each Part
[ self-Constrained Forces &

[] save output of Current Stage(Bq

Define Erection Load

Load Case Mame

Load Type for C.S.
Assignment Load Cases
Load Case

List of Load Case

Erection Load 10

Dead Load of Wearing Surfaces and Ut

Selected Load Case

LC10

>

Cancel

Remove Construction Stage Analysis Control Data

OK

Cancel

Construction Stage Analysis Control Data
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2. Multiple Modulus of Elasticity for Composite Prestressed Girder

- The modular ratio between slab concrete and girder concrete can be defined to determine the creep-transformed section properties of the composite section.

+ The tendon and reinforcement are not taken into account to calculate the creep-transformed section properties and hence approximate stresses.

Civil 2020 (v1.1) Release Note

=  Properties > Section > Composite
Section Data X Section Properties
DB,ﬂJser] \u'alue] SRC ]Combined] PSC ]Tapered Composite | Steel Girder]
sectond |6 | Neme [Composte | Value(Before) Value(After) Long Term Shrninkage Unik
Area 5.490254e+005 9.013707e+005 6.823557e+005 7.490254e+005 | mm"2
SectonType: | Composite-PSC v Asy 6.270599e+005 5.872924e+005 4.045292e+005 4 601618e+005 | mm"2
. Asz 4.4224172+005 3.684182e+005 3.279467+005 3.290320e+005 | mm~2
B [2000 0 Ixcx 1.659530e+010 1.894427e+010 1.748419e+010 1.792864e+010 | mm~4
t  [200 0 lyy 1.195447e+011 3.360157e+011 2.276104e+011 2.672750e+011 | mm™4
v [0 mm lzz 1.230070e+010 1.297491e+011 5.674514e+010 7.8967362+010 | mm™4
Cyp 3.750000e+002 3.750000e+002 3.750000e+002 3.750000e+002 | mm
Girder Cym 3.750000e+002 3.750000e+002 3.750000e+002 3.750000e+002 | mm
PSC Value Type Import... Czp 9.015894e+002 5.100687e+002 7.058782e+002 £.341514e+002 | mm
Czm 5.384106e+002 9.899313e+002 7.941218e+002 2.658486e+002 | mm
Qvb 0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 | mm~2
Qzb 0.000000e+000 0.000000e+000 0.000000e+000 0.000000e+000 | mm~2
Peri:0 4.314130e+003 8.714130e+003 8.714130e+003 2.714130e+003 | mm
Peri:l 0.000000=+000 0.000000e+000 0.000000e+000 0.000000e+000 | mm
Centery 3.750000e+002 1.000000e+003 1.000000e+003 1.000000e+003 | mm
_ Centerz 5.384106e+002 9.899313e+002 7.941218e+002 2.658486e+002 | mm
e ——— y1 -1.200000e+002 | -1.200000e+002 | -1.200000e+002 | -1.200000e+002 | mm
Display Centroid s z1 9.015894e+002 5.100687=+002 7.058782e+002 5.341514e+002 | mm
odfEsb | .13525| Dgdjbsb
Pad 0.2 o y2 1.200000e+002 1.200000e+002 1.200000e+002 1.200000e+002 | mm
FEM Eauaton _Togme (7 z2 9.015894e+002 5.100687e+002 7.058782e+002 6.341514e+002 | mm
[ Multiple Modulus of Elasticity v3 3.500000e+002 3.500000e+002 3.500000e+002 3.500000e+002 | mm
Egd/fEsb (Creep) z3 -5.984106e+002 | -9.899313e+002 | -7.941218e+002 | -8.658486e+002| mm
Offet: CenterCenter | EdafEsh (Shrinkage) v _3.500000e+002 | -3500000e+002 | -3500000e+002 | -3500000e+002 | mm
Change Offset .. 4 Consider Shear Deformation. =4 -5.984106e+002 | -9.899313e+002 | -7.941218e+002 | -8.658486e+002| mm
[ Consider Warpina Effect(7th DOF)
Show Calculation Results. .. Cancel Apply Close
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3. Improvement in Prestressed Composite Bridge Wizard: Non-continuous Precast Beam

- New option is introduced to apply non-continuous condition for the precast beams between neighboring spans.

- Bending moment is released at the slab connecting two spans.

Civil 2020 (v1.1) Release Note

= Structure > Wizard > Prestressed Composite Bridge

Pre/Post-Tensioned Composite Girder Bridge Wizard

Layout | Section I Tendon I Load | Construction Stage |

Bearing Type/Elastic Link Stiffness
Abutment Fixed

[y [1459.39 |jpym [z |14

| kx| 729695 | ki

Pier Elastic Link w 1.5e+01:| kMNfm Ky | 1.5e+01|kNfm
O Advanced... Elastic Link Length m
Pier

Material 2: Conc | [ Column
1: Column

Girder Type Precast Girder Type ~ Modeling Type All Frame ~
Span Information 2@34 m Deck Width 13 | m
Layout Offset 0 m Spacina(a) 0.15 m Gﬁ ﬁl
Support Skew Angle a deg  Spacng(b) 0.2 m A A
E——
[ continuous Girder )
[radius 0 m Concave Convex Multi-Curve Curve Data Coordinate Data Advanced...
Girder Alignment Same Spacing Guide. .. Reference Suppart Abutment 1
Boundary/Substructure
() without Substructure (®) with Substructure Guide...

59.39 | kpfm

CAE

Continuous Girder Continuous condition

Pier Cap Section hREID
Section 2: Pier Cap | = Height |-|-| | Advanced...
Length | 18 m Spacing | 3@5 |m
Pier Support | Fixed ~ | Harizontal 0 kdfm Yertical 0 kS Advanced...
Save s x Carce

Precast Composite Girder Bridge Wizard

[ ] continuous Girder

Non-continuous condition
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4. Improvement in Prestressed Composite Bridge Wizard: Diaphragm

- Individual diaphragms can be included/excluded in the modeling of prestressed composite girder bridge.

Civil 2020 (v1.1) Release Note

= Structure > Wizard > Prestressed Composite Bridge

Pre/Post-Tensioned Composite Girder Bridge Wizard

Layout Section ITendonI Load | Construction Stage |

Deck Thickness

Number of Girders I:I Apply Guide...

terdltigi: Girder No Girder Offs
Material
Deck L
2
Girder 3
Diaphragm 2: Conc ~ 4
=
Diaphragm Transverge Deck Element
Define Diaphragm Section... Spacing
Distances ~ ([ 1.524
Intermediate Spacing Divisions per Span ~ I Adv... I
Angle type
Divisions per
Diaphragm Mame Span Perpendicular
End Support

Advanced Diaphragm

Diaphragm Madeling
[JEnd Support
[Ipier suppart

L

Pier Support 3:CrossBeam
Intermediate |3:CrossEleam

Girder Information

Spanllspan2|

Define Girder Section..
Mo. of Divisions Apply Guide. ..

[ Generate 10th points elements

Ma. Mame Start (m) | End (m) "
Bl 5comp_Precast 0| 33925

Advanced Diaphragm

Diaphragm Madeling
End Suppart
Pier Support

Open... Save As... OK

Cancel |

Precast Composite Girder Bridge Wizard

No Intermediate Diaphragm

6/27



Civil 2020

Civil 2020 (v1.1) Release Note

5. Bilinear Type Spring Stiffness for Surface Spring Support
- Bilinear spring type is added in the Surface Spring Support to simulate the strength limit of the soil. The strength limit should be defined by the user.

« Both Point Spring Support and Elastic Link are supported.

= Boundary > Spring Supports > Surface Spring
10,0
10
Surface Spring Supports [ foue |Surface Spring Supports ~ |
Boundary Group MName Boundary Group Mame 10.
Default ~ Default ]| [
10.
Surface Spring Surface Spring
(®) Convert to Nodal Spring (®) Conwvert to Nodal Spring 10.
(®) Point Spring () Point Spring
() Blastic Link (®) Elastic Link 10
(O Distributed Spring (O Distributed Spring
10.
Aeg Ae
i 10
K= e Ks K=oy Kz Me 10,
At Effective Area per Mode At Effective Area per Mode
Kz :Modulus of Subgrade Reaction Kz :Modulus of Subgrade Reaction
10
Element Type Element Type
Frame ~ | Face #1 Frame ~ | Face #1 10. S . St th [kN]
pring Streng
: 10. = Section Width [m]x Element Length [m]x PHU [kN/m?]
Spring Type 10
Type Multiinear {Bi) ~ Type : Multiinear (Bi) ~ -
Modulus of Subgrade Reaction : Direction : | Normal(+) v 10,
Node Local Axis(f defined) Modulus of Subgrade Reaction : Horizontal Soil Stiffness(kN
i [somo_Jumes e o o
A
Ky : I:I kNfm~3 Limit Strength : 10.
ki [0 |uumes Nfm 2 Sori
pHU: |00 |Wume2 Length of Elastic Link : 10. pring
i Strength
[]pamping Constant / Area o 10 KN
cx |0 kN*sec{m™3 ( )
cy |0 kh*secim™3 10
cz |0 kh*secim™3 10. : :
Spring Stiffness (KN/m)
Close Apply Close 0 )} >
: Horizontal
Surface Spring Support Displacement (m)
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6. Force/Stress Contouring based on Center Value of Plate Elements

- Stresses at the node are determined by the linear interpolation of Gauss points, which often leads to stress exceeding yield stress in the material nonlinear analysis.

Civil 2020 (v1.1) Release Note

« Plate stress contour can now be displayed using the value at the element center instead of element nodes. The center values will not exceed the yield stress.

= Results > Results > Stresses > Plane-Stress/Plate Stresses

Add/Medify Plastic Material *
Name Model
[ stesl | [vonMises |

Plasticity Data

I Initial Uniaxial Yield Stress [ 340 | Njmm~2 I Yield Stress=340MPa
[[]Hardening
Isotropic Kinematic Mixed
Back Siress Coefficient 0
Hardering Coefficient 0 Njmme2

Larger than yield stress

MIDAS/Civil
POST-FROCESSOR

PLN ST5/PLT 5TR3
SIG-EFF TOP
414.7¢
373.28
33l.81
280.33
243.3¢
207.38
lg5.90
124.43
22.85
41.43
.00

Center Contour option

Tree Menu . x

Reactions Deformati.. Forces ESugi23{2l Strains

|Hane—5hessﬁ>1ate Stresses w | |Z|

Load Cases,Combinations
|ST: Load Sum w El
Step NL Step: 4 v

Stress Options
OLocal

@®ucs | CurrentUCS ~

[ Print UCS Axis

(®) Element () Avg. Nodal
Avg. Modal Active Only

® Top O Bottom
O Both Sides ) Abs Max

Components
Osigxx Osaw  OSaz
Osigxy  OSavz O Sigsz
O sigmax O sig-mn @ Sigeff
() Max-Shear

Type of Display
Contour  |...| [Joeform  [..]
[values = Legend [

[Janimate  [...] [ ]undeformed
Dvireed L
Yield Point ...

|:| Cutting Diagram I:l

Display Optien Detail X

Contour

Value

Max (®) Element Center

[ Apply On OK

==

Less than yield stress

MIDRS/Ciwvil
POST-FROCESSOR

FLH 3T3/FLT S5TRS3
S5IG-EFF TOP
308.08
278.17
247.28
216.35
185.45
154.54
123.63

92.72
£l.32
30.91

.00

With Center Contour option
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7. Concurrent Reactions of Moving Load Analysis with respect to Node Local Axis

- Concurrent reactions due to moving load case can be viewed with respect to node local axis as well as global axis.

This is useful to check concurrent reactions in the skewed bridges or horizontally curved bridges.

; Fi ; L Fi v ” Jlrff ll.l;! .l’éf v /r'J ll.l;! Jlrf.l’ f)"f - Fi jjf - Fi ” gf Fi f .'l f f
77777777 /////////////////g
A A S S 5 S S S S S A A A Y 5 Y S B S P ¢
///////5///////////5////////35
e
7 7 A A A S S 55 i /7‘;5

i
il £ Fi 7 Fi il Fi il )’ r’ i Fi

= Result Tables > Concurrent Reaction

Support and Node Local i
axis not parallel to global
axis in the skewed bridge Sg

Load Case Node 312 213 ~
Mode Reaction FX | FY | Fz | WX | % | Wz FX | Y | FZ | X WY | uz FX | FY |
) ) i) (hem) (kh*m) (ktitm) () IC) ) (tiem) iem) (khem) ) (kN
11111 | Al ULSTNV:max | Apply

FXON) 193.3470 0.0000] 444303 0.0000 0.0000 0.0000]  19.6739 0.0000]  39.2917 0.0000 0.0000 0.0000] -178.7430 0.0000
FY(KN) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
FZ(kN) 165,650 0.0000| 08802 0.0000 0.0000 0.0000| -87.8688 0.0000 | 154.4990 0.0000 0.0000 0.0000 | 227.4120 0.0000
WX(NFm) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
WY (KN 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
WZ(N'm) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
FXIKN) 135.4230 0.0000| 408512 0.0000 0.0000 0.0000|  83.3519 0.0000 | -15.4524 0.0000 0.0000 0.0000|  39.3949 0.0000
Define Concurrent Reaction Group e FY (I} 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
a1 FZikN) 1341910 00000 | 350869 00000 00000 00000 | 852902 0.0000 | 2613780 0.0000 00000 00000 | -169.0720 0.0000
WX(Pm) 0.0000 0.0000 00000 00000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 00000 00000 0.0000 0.0000
Node Group Selected Group WY (k) 0.0000 0.0000 00000 00000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 00000 00000 0.0000 0.0000
EETING Dok A rE WZ(Km) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
South Bridae FX(KN) 129.5600 0.0000| 391018 0.0000 0.0000 0.0000|  60.0568 0.0000 | -14.8024 0.0000 0.0000 0.0000| 405398 0.0000
North Bri dge FY(kN) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
FZ(kN) 121.4410 00000 367324 0.0000 0.0000 0.0000| 962584 0.0000 | 229.9700 0.0000 0.0000 0.0000 | -179.8540 0.0000
NO”QWIE“ ddeg‘( > a4 WX(N"m) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
Sou m“ est b = o WY (k) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
Southeast ; deck WZ(NFm) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
CE”;E'SN‘; cke FX(KN) 288074 0.0000 51753 00000 00000 0.0000 43608 00000 | 448575 0.0000 00000 00000 | -35035 0.0000
Martheast Eﬁ1 deck FY (k) 111,200 00000 | 339288 00000 00000 00000 656059 00000 | -10.8590 0.0000 00000 0000 | 178776 0.0000
ﬁa?g:&(ﬁ; = << s FZ{kN) 1511740 00000 | 336825 00000 0.0000 00000 133552 00000 | 485736 0.0000 00000 0.0000 | -155 3080 0.0000
P WX(hPm) 0.0000 0.0000 00000 00000 0.0000 0.0000 0.0000 0.0000 5.0000 0.0000 00000 00000 0.0000 0.0000
SW De ; deck WY (Rm) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
CEn;EiOU p cke p i WZ(km) 0.0000 0.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
Sou S?St eck diap FX(RN) 136.5600 0.0000| 287323 0.0000 0.0000 0.0000| 846647 0.0000 | 2028450 0.0000 0.0000 0.0000 | -160.8580 0.0000
SE De ckLS'S " FY(kNY 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
NW Deck diaphragm v e FZ(KN) 1212110 0.0000| 329305 0.0000 0.0000 0.0000| 628156 0.0000 | -11.6060 0.0000 0.0000 0.0000|  -38166 0.0000
WXCN ) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
Remove Concurrent Reaction Group WY (k) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
WZ0m) 0.0000 0.0000 00000 00000 00000 0.0000 0.0000 0.0000 0.0000 0.0000 00000 00000 0.0000 0.0000
Cancel FX(KN) 160.8810 00000 | 498877 00000 00000 0.0000| -1002810 0.0000 | 155.0840 0.0000 00000 00000 | -2287280 0.0000
FY(kN) 0.0000 0.0000 0.0000 00000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 00000 00000 0.0000 0.0000
a7 FZikN) 1256970 00000 | 384487 00000 0.0000 00000 782017 00000 | 144385 0.0000 00000 00000 | 397817 0.0000
WX(Pm) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000
WY (k) 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000

0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 vo000 | .,

) |\ Concurrent Reactidh A Concurrent Reaction(Local) / I || < >
q (3 wipas/Cuir, [ Result-[Concurrent(Max/Min) Reaction)] | b

Concurrent Reaction (Local) .
Concurrent Reaction Table
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8. Concurrent Forces of Elastic Links and General Links for Moving Load Analysis

« Concurrent forces of Elastic Links and General Links are provided for the moving load analysis.

- This is useful when the bearings of the bridge are simulated using Elastic links.

Civil 2020 (v1.1) Release Note

= Analysis > Analysis Control > Moving Load,

Maoving Load Analysis Control Data

TruckTrain Load Control Option

Analysis Method

(®) Exact O Pivot O Quick
Load Point Selection

(7 Influence Line Dependent Point (®) All Points

Influence Generating Paints
(®) Mumber Line Element :

() Distance between Paints :

Analysis Results
Flate

() Center
(®) Center + Nodal

|:| Stress

D Concurrent Force

Frame

(®) Normal

O Normal + Concurrent
Force/Stress

Combined Stress

X

Concurrent Force of Elastic/General Links

~[Flcalculation Fiters

Reactions
®al (O Group :
Displacements
®all (O Group :
Forces/Moments
®all (O Group :
Elastic/General Links
Cal ®Group: EL ~
Cancel

Result Tables > Elastic Link,

Result Tables > General Link

Axial Shear-: Shear-z Torsion Moment- Moment-z
e toad | Mode | ps) ops) (kips) (ftkips) (ios) c
WMVL(max) 57 0.74 13.18 49.60 0.00 0.00 oy
1 | MVL{max) 1 0.74 1319 48 60 0.00 0.00 Find...
2 | MVL{max) 59 0.00 0.00 0.00 0.00 0.00
2 | MVL{max) 21 0.00 0.00 0.00 0.00 0.00 Saorting Dialog...
3 | MVL{max) 58 0.00 13.89 0.00 0.00 0.00 Style Dialog..
3 | MVL{max) il 0.00 13.88 0.00 0.00 0.00
4 | MVL{max) 60 0.00 0.00 0.00 0.00 0.00 Show Graph...
4 | MVL{max) 3 0.00 0.00 0.00 0.00 0.00
1 | MVL{min}) 57 -140.87 -13.89 -47.10 0.00 0.00 Activate Records...
1 | MVL{min 1 -140.87 -13.89 -47.10 0.00 0.00
2 MVLEmin; 59 0.00 0.00 0.00 0.00 0.00 i
2 [ WVL(min) 21 0.00 0.00 0.00 0.00 0.00]| | view by Maxvalue ftem... |
3 | MVL{min) 58 -14187 -13.19 0.00 0.00 0.00
3 | MVL{min}) i -141.87 -13.19 0.00 0.00 0.00 Dynamic Report Table.
4 | MVL{min} 60 0.00 0.00 0.00 0.00 0.00 == Result View ltems
4 | MVL{min) 31 0.00 0.00 0.00 0.00 0.00 0.0}
Items to Display Load Cases to Display
] [Jo=ad Load(sT)
Elastic Link Force Table Shear-y [sidensk LoadsT)
Shear-z ] My28(ST)
| Tarsion [|MvL (vl
Moment-y [ | MYL (M :mizad)
Moment-z [ | MVL (MV; min)
[|LcB1{cB:al)
[ |LcB1(CB:max)
[ ]Lce1(cB:min)
Axial Shear-y Shear-z Torsion M it- M t
No. Load Node Component (kips) (kips) (kips) (f*kips) (f*Kips) (f*kips) —
» MWL (max) 57 Axial 0.74 -0.45 1.60 0.00 0.00 0.00
1 | MVL{max} 1 Axial 0.74 -0.45 1.60 0.00 0.00 0.00
2 | MVL{max) 59 Axial 0.00 0.00 0.00 0.00 0.00 0.00
2 | MVL{max) 21 Axial 0.00 0.00 0.00 0.00 0.00 0.00
3 | MVL(max) 58 Axial 0.00 0.00 0.00 0.00 0.00 0.00
3 | MVL(max) ik Axial 0.00 0.00 0.00 0.00 0.00 0.00
4 | MVL{max} 60 Axial 0.00 0.00 0.00 0.00 0.00 0.00
4 | MVL{max) 31 Axial 0.00 0.00 0.00 0.00 0.00 0.00
1 | MVL{min} 57 Axial -140.97 -0.32 1.14 0.00 0.00 0.00
1 | MVL{min} 1 Axial -140.87 -0.32 1.14 0.00 0.00 0.00
2 | MVL(min} 59 Axial 0.00 0.00 0.00 0.00 0.00 0.00
2 | MVL{min} 21 Axial 0.00 0.00 0.00 0.00 0.00 0.00
3 | MVL{min} 58 Axial -141.897 0.82 0.00 0.00 0.00 0.00
3 | MVL{min) il Axial -141.97 0.82 0.00 0.00 0.00 0.00
4 | MVL(min} 60 Axial 0.00 0.00 0.00 0.00 0.00 0.00
4 | ML {min} 31 Axial 0.00 0.00 0.00 0.00 0.00 0.00

Moving Load Analysis Control

Concurrent Forces of Elastic Links
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9. Analysis Filtering of Elastic Links and General Links in Moving Load Analysis

+ The user can choose a group of Elastic Links and General Links to be analyzed for the moving load cases.

- This filter option makes the analysis time much shorter when there are a lot of Elastic Links / General Links in the model.

Civil 2020 (v1.1) Release Note

= Analysis > Analysis Control > Moving Load

Moving Load Analysis Control Data

Truck/Train Load Control Option
Analysis Method

(®) Exact (CIPivot () Quick
Load Point Selection
(O Influence Line Dependent Paint (@) All Points

Influence Generating Points

(®) Number [Line Element : 5 =

O Distance between Points 1]

Analysis Results

Plate Frame
() center (®) Mormal
@ Center + Nodal ®) Mormal + Concurrent
Force(Stress
[ 5tress
Combined Stress

D Concurrent Force
Concurrent Force of Elastic/General Links

IE‘CaIcuIation Filters

Reactions
® al ()Group :
Displacements
[OF] () Group :
ForcesfMoments
[OF] () Group :
Elastic/General Links
Oal (@) Group EL w

Select the boundary group.

Cancel

Moving Load Analysis Control

Tree Menu

Tables ‘Works EEGI:N Report

.E_q Group
= @ Structure Group : 1
@ Cross Beam [ Node=0 ; Bement=101 ]
= =L Boundary Group : 1
=L EL
J,"_ Load Group : 0
#—4 Tendon Group : 0

Assign a boundary group
to Elastic Links representing
bearings.

Elastic links assigned to piles are not
computed for moving load analysis.

N
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10. New Inelastic Hinge Type: Parametric P-M (multi-curve)

- Parametric P-M (multi-curve) is a new inelastic hinge type described by bending moment vs. curvature relationship which is a function of the axial force.

+ Unlike the other types of hinge, the moment vs. curvature relationship can be defined by the user depending on the axial forces.

= Properties > Inelastic Properties > Inelastic Hinge

Add/Modiy Inclastc Hinge Properties x| e The flexural behavior of the beam element is described by bending

N : [ | moment vs. curvature relationship. This relationship is input in the

o | —— form of multilinear functions. The moment vs. curvature relationship
@ beam-Column @RC/RC(encased) is a function of the axial force.
() Truss () General Link () Steel/SRC(filled)
e e ot hets oo ol  The flexural behavior of the beam element is defined by two bending
@Vonent - Curvature (oiDistrbutee) (] O Fber Mosel vs. curvature relationships, one for each principal plane of inertia,
Inferacton Type Fiber Secton Interaction between the two bending moments (My and Mz) are not
oL Auto Generaton (©)User Defined taken into account.

(O P-Min Strength Calculation

(O PMM in Status Determination

&
E I:)n+:l
Compeonent Properties E
Component Mo, of Sections Hysteresis Model ECI Pn

[Fx 3 KinematicHardening - Properties...
D Fy 3 Karem - Properties...
([ 3 Kinem - Properties. .. Pﬁ_1

Mx 3 Kinematic Hardening - Properties...
My P-M Multi-Curve Type v || Properties... P: axial force
Mz P Multi-Curve Type - Properties...

‘ield Surface Properties...
Cancel Apply
Curvature

Inelastic Hinge Properties

MibAS 12/27
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10. New Inelastic Hinge Type: Parametric P-M (multi-curve) continued

- Ultimate positive and negative curvature can be specified.

+ This hinge type can be applied to nonlinear static or nonlinear time history analysis.

= Properties > Inelastic Properties > Inelastic Hinge
* P-M Multi-Curve Type allows for bilinear and multilinear plasticity.

« The first data point corresponds to negative rupture and the last data

Directional Hinge Properties : P-M Multi-Curve Type X point corresponds to positive rupture. One data point — the zero point
Mult Curve Data primary Curve — must be at the origin. A different number of data points can be used
ulti-Curve efine Axial Force S — - . .
e e —— for the positive and negative sections of the curve.
Axial Force (P) 0.000 w | kN

Multi-Linear Force & Deformation

« Moment and curvature relationship can depend on the axial force

Curvature Moment ~
N and the dependence can be different in tension and in compression.
-5.000e-001 -1.001e+003 .
2] 1.0006-001 | -1.0006+003 The number of axial forces must be two at least.
3| 0.000e+000| 0.000e+000
4| 1.000e-001| 1.000e+003 . . .
5| 5000e-001| 1.001e+003 Deformatton Indexes » To obtain the bending moment-curvature curve for a level of axial
sgin Hardgningwpeo | force not input, interpolation is used. This interpolation is performed,
“I s — not on the bending moment-curvature curves, but on the moment-
Tniil Siffness plastic curvature curves. The moment-plastic curvature curves are
& s automatically calculated from the bending moment-curvature curves.
¢ ™2
OK Cancel

« Strain hardening can be isotropic, kinematic or mixed. The moment-
curvature relationship can either be symmetric or non-symmetric.
Whether it is symmetric or non-symmetric, entire moment-curvature
curve should be entered.

MibAS 13/27
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11. Precast Concrete Girder Section Database Update: AS-Super T RMS 2019
- AS-Super TRMS2019T1,T2,T3,74,T5

« This section database is also updated in the Tendon Template.

= Properties > Section > PSC

Section Data % Select PSC DB w
DBfUser I Value I SRC I Combined PSC |Tapered I Composite | Steel Girder I Code |AS ~ Type AS-Super-T_RMS_2019
Select DB
SectonID |1
'@7 PSC-Value ~ 272
3T3
MName Mesh Size for 5tiff, Calc. mm 474
5:TS
r—r—
Section Data = Calc. Section Properties
Area 4.59271e+005 | mm*2 -
L M 1.98204e+005 | mm*2 Aute Generation x
Param. for Design Asz 1.28248e+005 | mm*2
Mame prefix = | strand |
1 mm e 6.24376e+009 | mm*d
lyy 3.14046e+010 | mmrd Tendon Property 1 | Tendon s
T2 =
o lzz 1.02028e+011 | mm*4 Tendon Group . | Default w
BT mm Cyp 1050.0000 | mm Ex - B -
HT 1000 mm Cym 1050.0000 | mm
CZp 2149670 | mm Type :I AS-Super-T_RMS_2019 VI
Thk. for Torsnon(mln.}A . Czm 3500340 | mm Name LT =
o L Qyb 270791 5445 [mm2 |, Origin Point : [0.370, 0.000 |m
Initialize Tendon T te
[+] Consider Shear Deformation [ consider Warping Effect(7th DOF) 4 Inifialize Tendon Temola
Warping Check Auto Uszer
Shear Chedk

Position Qy Auto  Thk. for Shear(total) Auto
Z2: Centroid 0 mm*3 0 mm
Z3: mm 0 mm~3 1 |0 mm
Offset: Center-Center
Change Offset ... Display Centroid
Show Calculation Results... Cancel Apply

Tendon Template

n’ﬁlﬁ 14/27
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12. Response Spectrum Function: AS 5100.2: 2017
 Response spectrum function as per AS 5100.2: 2017

= Load > Response Spectrum Data > RS Functions

Add/Modify/Show Response Spectrum Functions X Generate Design Spectrum oo
Function Mame Spectral Data Type
| AS 5100,2(2017) | (®) MNormalized Accel. (O Acceleration (O velocity () Displacement Design Spectrum : AS 5100.2(2017) it
Scaling Gravity Graph Options Site Sub Sail Cl
: 3 " 3 | Ll ol Llass
= (®) Scale Factor mm}sec“‘z [ %-axis log scale O O @
: i ' Ag Be e
Period | Spectral Data| ~ ! bEnzrm i .
Maximum Value 0
(sec) (a) . ? [ y-axis og scae () De O Ee
1 m 0.0901
2| 00600 0.1891 o.za1022 43
3| 0.1000 0.2551 \ Probability Factor (kp)
4| 01200 0.2551 0.1510332
5 0.1800 0.2551 E Hazard Factor {2} 0.08
5] 0.2400 0.2551 A 0.141022
7] 03000 0.2551 I~ \ Design Ductility Factor (1)
2| 023600 0.2407 5 o0.osioaza .
9| 0.4200 0.2063 v e
[N
10| 04800 0.1806 " 5 oat0azs A
.
11 0.5400 0.1605 —
12| 0.6000 0.1444 -0.00B56769
13| 06600 01313 0.01 1.01 2.01 2.01 4.01 5.01 £.01
14| 07200 01204 ¥ Pericd (sec) Max. Period : | 6 | (5ec)

Description | AS 5100.2(2017): SC=Ce, kp=1.30, Z=0.08, u=1.50 |

oK Cancel || Apply Cancel
Response Spectrum Functions Design Spectrum
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13. User-Defined Drying Basic Shrinkage Strain: AS 5100.5-2017

+ The development of shrinkage strain can be defined using user-defined drying basic shrinkage strain as well as recommended values for each cities when applying AS 5100.5-2017.

= Properties > Time Dependent Material > Creep/Shrinkage

Add/Medify Time Dependent Material (Creep / Shrinkage) pod
Name: | | Code: | AS5100.5-2017 v
ALSTRALIA
Compressive strength of concrete at the age of 28 days : M fmm2

Exposure Environment
[ () Interior () Temperate Inland () Tropical or Mear Co

Hypothetical Thickness :

h =2 Ag fu (Ag : Section Area, u : Perimeter in contact with atmosphere)

Show Time Dependent Material Function x

Creep Function Data Type Graph Options
[ -axiz log scale [ v-axiz log scale

Start Loading : 10 Day a.s e
d Load 10000 D T
. e g g End Loading : ay
Crying Basic Shrinkage Strain {108 : Num. of Ste 24 2 -
um. o pe ! o

(") 800.0 (Sydney, Brisbane) (") 500.0 (Melbourne) () 1000.0 (E|

Time

6.5088e-005
Age of concrete at the beginning of shrinkage : == 7_5954:_005

2371| B8.6367e-005
31.62 | 9.6099e-005
4217 | 1.0540e-004
56.23 | 1.1491e-004
7499 | 1.2537e-004

100.00 | 1.3726e-004 °
0 1000 2000 2000 4000 S000 €000 7000 BO00  S000 1050
13335 | 1.5077e-004

w Time (day)
ATTF 0D 4 EREOOA NMNA

Time Dependent Material (Creep/Shrinkage) TEiEr ] Close
Shrinkage development

w
*
F
Shrinkage Strain(x-1E-4)
-
n 13
———

Show Result... | OK | | Cang

o w oo = || e ek

a
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14. Relaxation of Tendons: AS 5100.5-2017

« Prestress loss due to the relaxation of tendon is calculated as per equation 3.3.4.3 of AS 5100.5-2017 using user-defined basic relaxation, Rb.

= Rb(%) is the basic % relaxation of a tendon at 1,000 hour.

Civil 2020 (v1.1) Release Note

= load > Load Type > Temp./Prestress

Load > Prestress Loads > Tendon Property

Add/Modify Tendon Property

Tendon Type
Tendon Name | Top
Tendon Type Internal(Post-Tension) ~
Material 3: 18505 e
Total Tendon Area | 2774 | mm~2 B
Duct Diameter | 0 | —
Relaxation Coefficent AS 5100,5-2017 ~ | Rb(%]) | 2.5
Characteristic Value of Strength (fpb) | 1850 | M fram <2
Curvature Friction Factor | 0.3 |
Wobble Friction Factor | 6.6e-006 | 1/mm
External Cable Moment Magnifier 0 N/fmm~2
Anchorage Slip{Draw in) Bond Type
Begin Emm (®) Bonded
End . I:l mm () Unbonded
0K Cancel Apply

Tendon Property

3.3.4.2 Basic relaxation

The basic relaxation of a tendon (Rs) after one thousand hours at 20°C and 0.8f; shall be
determined in accordance with AS/NZS 4672.1.

3.3.4.3 Design relaxation

Subject to Clause 3.3.4.4. the design relaxation of a tendon (R) shall be determined from the
following equation:

R =ls ki ks Re ...3.3.43
where
ks = a coefficient. dependent on the duration of the prestressing force
= log [5.4(/)¥¢]

Jj = time after prestressing, in days

k7 = a coefficient, dependent on the stress in the tendon as a proportion of fps.
determined from Figure 3.3.4.3

ks = a coefficient, dependent on the average annual temperature (7) in degrees
Celsius, taken as 7/20 but not less than 1.0

R, = basic relaxation of a tendon after one thousand hours at 20°C, as specified in

Clause 3.3.4.2

AS 5100.5-2017 Specification
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15. User-Defined Stress Limit for Crack Check: AS 5100.5-2017

« For the crack control for flexure in prestressed beams, the maximum increment of steel stress was fixed as 160 MPa in the previous version.

+ Now, it can be defined by the user.

Civil 2020 (v1.1) Release Note

PSC > Design Parameter > AS 5100.5: 17

PSC Design Parameters

Design Code : AS 5100.5:17

Input Paramaters

o9t 5 |m

Qutput Paramaters
Ultimate limit states
Flexural resistance
Shear resistance

Torsional resistance

Maximum nominal aggregate size (28.2.4.2) Crack Control

Maximum Increment of Steel Stress

Njm-2

Serviceability limit state

| selectal | | Unselectal |

PSC Design parameter

Super T Girder Bridge
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16. Dynamic Load Allowance for Expansion Joint: AASHTO LRFD

+ Dynamic load allowance is defined in the Vehicle dialog in the moving load analysis by AASHTO LRFD.

- Different dynamic load allowance can now be applied to a separate structure group using this new feature.

Civil 2020 (v1.1) Release Note

* Load > Load Type > Moving Load > Moving Load Code > AASHTO LRFD

= Load > Moving Load Analysis Data > Dynamic Load Allowance

Dynamic Load Allowance

Select Structure Group

X

| |Cross Beam 1
Deck Joints

Deck Joint IM | 75 %
Add Maodify Delete
Group List Factor
Deck Joints 75
Close

Table 3.6.2.1-1—Dynamic Load Allowance, IM

Component

Deck Joints—All Linut States

All Other Components:

¢ Fatigue and Fracture Limit State

e  All Other Linmit States

AASHTO LRFD Specification

Dynamic Load Allowance

Truck loads on the deck joint
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17. Standard Vehicles: Indiana Department of Transportation

Civil 2020 (v1.1) Release Note

+ Toll Road Loading No.1, Toll Road Loading No.2, Special Toll Road Truck, Michigan Train Truck No.5, Michigan Train Truck No.8

+ SUPERLOAD - 11 Axles Loading, SUPERLOAD - 13 Axles Loading, SUPERLOAD - 14 Axles Loading, SUPERLOAD - 19 Axles Loading 1, SUPERLOAD - 19 Axles Loading 2

Load > Load Type > Moving Load > Moving Load Code > AASHTO LRFD

Load > Moving Load Analysis Data > Vehicles
Define Standard Vehicular Load

Standard Name
INDOT Load i

Vehicular Load Properties

Vehicular Load Name : Michigan Train Trudk Me. 5

Michigan Train Truck Mo. 5

Vehicular Load Type :

D ic Load All :
b Rl A e Toll Road Loading Nao. 2

Special Toll Road Truck
Michigan Train Truck No. 5
Michigan Train Truck No.&

Pz Ps P SuperLoad - 11 Axles Loading
SuperLoad - 13 Axles Loading
SuperLoad - 14 Axles Loading
............... SuperLoad - 19 Axles Loading 1

f#—SuperLoad - 19 Axles Loading 2
I D2 Dz iz} Ds D& o7

No  Load{kips) Spacing(ft) w [0 kips/ft

1 12 g ps |0 kips

2 16 3.5 om |0 kips

3 15 9

4 18 9 dwi |0 kips /ft

5 18 9 doi |0 ft

5] 18 9

7 18 g dwz |0 kips/ft

8 18 end doz |0 ft
Cancel Apply

INDOT Load Rating Vehicles

150

18.0K 18.0K 18.0K 18.0K 18.0€ 180k
ltoo 4o 260" Jew| 2o | 200"
SPECIAL TOLL ROAD TRUCK
(W = 126.0K)
16.0K 16.0K 18, |

"—L—J———l-—-l-—-l-——l

MICHIGAN TRAIN TRUCK NO. 5

(W = 134.0K)
| 132" | ! 507"

PERLOAD - 11 AXLES LOADING
(W = 258.0K)

P
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020

18. Standard Vehicles: Colombian CCP-14
+ CCP-14 Truck, CCP-14 Tandem

Civil 2020 (v1.1) Release Note

Load > Load Type > Moving Load > Moving Load Code > AASHTO LRFD, Load > Moving Load Analysis Data > Vehicles

Define Standard Vehicular Load

Standard Name
Colombia

Wehicular Load Properties

Vehicular Load Name : | CCP-14 Truck

Vehicular Load Type *

Dynamic Load Allowance :

CCP-14 Truck ~

X

P, P P:
S
(@) Ymmm o
nh Dz~ Ds
Py Pz Py Py Pz P
4 1 1 w_ ¥ l 1 xr
(o) ¥ S—
"o D: bist oD Dz
Lane Support-Neg. Moment/ Reaction | Application
Not assigned a
Assigned ab
Mo Load (kM) Spacing{m) W 10.3 kN/fm
1 0 4.3 r Py 8
2 160 4.3 Dist, | 15 m
3 160 3
Cancel Apply

Define Standard Vehicular Load

Standard Mame
Colombia

ehicular Load Properties

Vehicular Load Name : | CCP-14 Tandem

Vehicular Load Type : £CP-14 Tandem

Dynamic Load Allowance :

¥ ¥
(@) e oS
D
P4 P P4 Pz
| . | .
! Il 1 |
! D Dist | i}
Lane Support-Neg. Moment/ Reaction | Application
Mot assigned a
Assigned a b
Mo Load (kM) Spacing(m) W 10.3 kN/fm
1 125 1.2 r 100 E
2 125 end Dist, | 8~12 m
Cancel Apply

40 kN

4300 mm 4300 a 9000 mm _J
e

600 mm General

300 mm Vuelo sobre el tablero

Figura 3.6.1.2.2-1 — Caracteristicas del Camidén de

Diseno

160 kN

1800 mm

. -

Carril de disefio 3600 mm
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19. Auto-Generation of Load Combination: BS 5400

- Auto-generation of load combinations with respect to BS 5400 is now available for concrete structures.

Civil 2020 (v1.1) Release Note

= Results > Load Combination

Load Combinations O
General |5heel Design I Concrete Design | SRC Design | Composite Steel Girder Design |
Load Combination List Load Cases and Factors
No | Name | Active Type Description 2 LoadCase Factor
» 1 Active Add ULS Comb 1: 1.32D+1. 1.3200
2| gLCB2 | Active Add ULS Comb 1: 1.32D+1. DW(ST) 1.9250
3| gLCB3 | Active Add ULS Comb 1: 1.32D+1. DC(ST) 1.3200
4]|gLCB4 | Active Add ULS Comb 1: 1.32D+1. EV(ST) 1.3200
5| gLCB5 | Active Add ULS Comb 2: 1.32D+1. EP(ST) 1.6500
6] gLCB6 | Active Add ULS Comb 2: 1.32D+1. EH(ST) 1.6500
7| gLCB7 | Active Add ULS Comb 2: 1.32D+1. STL(ST) 1.3200
5| gLCB8 |Active Add ULS Comb 2: 1.32D+1. Settlement(SM) 1.3200
9] gLCBY | Active Add ULS Comb 2: 1.32D+1. PS(ST) 1.1000
10| gLCB10 | Active Add ULS Comb 2: 1.32D+1. CR(ST) 1.3200
11| gLCB11 | Active Add ULS Comb 2: 1.32D+1. SH(ST) 1.3200
12| gLCB12 | Active Add ULS Comb 2: 1.32D+1. Dead Load(CS) 1.3200
13| gLCB13 | Active Add ULS Comb 2: 1.32D+1. Tendon Secondary(CS) 1.1000
14| gLCB14 | Active Add ULS Comb 2: 1.32D+1.
15| gLCB15 | Active Add ULS Comb 2: 1.32D+1.
16| gLCB16 | Active Add ULS Comb 2: 1.32D+1.
17| gLCB1T | Active Add ULS Comb 2: 1.32D+1.
18| gLCB18 | Active Add ULS Comb 2: 1.32D+1.
19| gLCB19 | Active Add ULS Comb 2: 1.32D+1.
20| gLCB20 | Active Add ULS Comb 2: 1.32D+1.
21| gLCB21 | Active Add ULS Comb 2: 1.32D+1.
22| gLCB22 | Active Add ULS Comb 2: 132041 | v
Import... Auto Generation... Spread Sheet Form Copy into Steel Design
File Name: | C:\UsersinskD201\Desktop\BS Assessment|L CBL.CE.Icp | Erowse Make Load Combination Sheet Close

Automatic Generation of Load Combinations

Option

® add O Replace Add Envelope

Code Selection

Osteel ®concete OsRc O Steel Composite
Design Code : BS 5400 £

Manipulation of Construction Stage Load Case

5T Only O csonly ® sT+CS
5T : Static Load Case C5 : Construction Stage

Bridge Type Roadway ~
—E‘ Load Factors for Permanent Loads
| Type of Load ‘ Load Factor
Max Min Both
bead Load ® O O
Ped( Surfacing(DW) ® (@] @]
bther Loads{DC) ® O @]
I‘Jertal Earth Pressure ® O (@]
"ﬂonwerhal Earth Pressure ® O O
Partial Safety Factor for Moving Load
Road Traffic Case : HB ~
BS Vehide Type : HE alone a

BS Vehide Partial Factor Table

Load Case Vehide Name

HA HA alone

HABHB HA with HB

HE HB alone

pelete
Partial Load Factor for Inaccurate Load Effect
For Ultimate Limit State
Fcr Service Limit State 1.00
_DK Cancel

ULS and SLS combinations

Selecting BS 5400 for Auto Load Combinations
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20. Design Report in Czech

+ The design reports are provided in Czech for the composite steel girder design and prestressed concrete girder design as per Eurocode.

Civil 2020 (v1.1) Release Note

= Design > Composite Design > Excel Report, PSC > PSC Design > Excel Report .
Al - I
Al13 - j‘\ ABCDEFGH I JKLMNOPQRSTUWVWXY 7ZAABACADAEAFAG
5 | 1.Nastaveni posudku
A B CDEF GH I J K LMNOPGRSTU Y WXY 7 5ABACADAE S AG 6 14 Névhové perametry
4 1 Podminky navrhu 7 _ Diléi souginitele pro mezni stav dnosnosti (EN 1992-1-1:2004, 2.4.2.4)
b 1.1 Névrhové parametry 8 Névrhové situace Vs beton V= betonafska wztuz v= predpjata wztu?
[ W Dilci souCinitele 9 Trvalé & Doasné 1.500 1.150 1.150
7 Ve pro beton 1.50 [y pro sprahovaci trmy 125 10 Mimofadné 1200 1.000 1.000
8 s pro betonafskou wztuz 115 |yer pro ekvivalentni konstantni rozkmit napéti 1.00 11
o] mo pro konstrukéni ocel 1.00 |yus pro tinavovou pevnost 1.00 12 - souéinitel @oe, 0y - Souéinitel pro dlouhodobé Géinky (nosnosti v tlaku a tahu.
10 it pro konstrukéni ocel 110 [yaue .= pro dnavovou pevnost trl ve smyku 1.00 13 Oge = 0.850 (pro dnosnost betonu v tlaku)
11 14 Qg = 1.000 (pro Gnosnost betonu v tahu)
12 1.2 Materialové informace 15 L
13 W Konstrukéni ocel 1? 1.2 F‘rure;y" — T T (T T [ (B e
rifezové . prif. 3 3 . prif. (Po spfazeni
14 f = 355.000 |MPa E = 205000.000 |MPa 18 charakteristiky pE:oranI(J]WZt) (N:::1|'k{+ Des(ka] !
15 19 A (mm?) 301674.143 663314.768
16 W Betan 20 ly (mm) 19347928584 907 45430636187 532
17 f | = 40.000 MPa [ 35220.462 MPa o1 R - 460,250
12 22 Yy (mm) - 414.710
19 B Vyztuz 23 ve  (mm) 469,682 310.261
50 f = 400.000 MPa E, = 205000 000 MPa 24 ve  (mm) 280,318 439739
21 25 7o (mmY) B 98678230 689
22 1.3 Informace o prifezu 26 Zp (mm) - 1095623952.619
23 27 Z(mm) 39392059 949 146394744 529
™ ) . h 28 Z, (mm’) 20227260.040 103290078.773
o5 29
- J | ;
57 g Fraes i) - s s s s+ = s
28 a3
29 L o . g 34
30 a5
31 i 16
32 ar
33 3 38
34 4 39
35 H 40
36 1 41
37 ' 42
38 L th J 42 :
Elem_172.i Elem_172 @ i 8 4 71 | 264l Bending Resistance shea ... (#) 4 3
Design Report — EN 1994-2 Design Report —EN 1992-2
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21. Response Spectrum Function: Philippines DPWH-BSDS 2013
- Department of public works and highways bridge seismic design specifications 2013, Philippines

Civil 2020 (v1.1) Release Note

= Load > Response Spectrum Data > RS Functions

Add/Modify/Show Response Spectrum Functions
Function Mame Spectral Data Type
| DPWH-LRFD BSDS{2013) | (®) Mormalized Accel. () Acceleration () velodity () Displacement
Scaling Gravity Graph Options
ot . (599 e Lppmes et
Period | Spectral Data| ~ . Damping Ratio ]
M Val 0
(sec) (g} O Maximum value [ -auis log scale
1 m 0.5000
2| 0.0600 0.7357 1-0ez I \
3| 01200 0.9714 b-sez f \
4 0.1527 1.1000 0.gez
5 0.1800 1.1000 = 0-7s2 \
i} 0.2400 1.1000 & 0653 \
i 0.3000 1.1000 o 0.552 "
8| 03600 1.1000 H 0482 \\
o 04200 1.1000 U 0283 .
[N \
10| 0.4800 1.1000 " p.zsz —
11| 0.5400 1.1000 0.182 =
—
12 0.6000 1.1000 0.092
13 06600 11000 o001 1.01 2.01 a.ol 4.01 5.01 €.01
14| 07200 11000 ¥ Period (s=c)
Description | DPWH-LRFD BSDS(2013): GT=I, PGA=0.50, 5s=1.10, 51=0.560, RMF=1.00
oK Cancel Apply

Generate Design Spectrurn x
Design Spectrum : DPWH-LRFD BSDS(2013) ~
Ground Type
®1 On Ot

Peak Ground Acceleration Coeffident
(PGAY

Spectral Acceleration Coeffident at
Period 0.2 sec (5s)

Spectral Acceleration Coeffident at
Period 1.0 sec (51)

Response Modification Factor (R)

Max. Period : | & | (Sec)

- =
o
<

Cancel

Response Spectrum Functions

Design Spectrum
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22. India Material Database Update

« Concrete: IRC:112-2011, IRS Concrete Bridge Code

Civil 2020 (v1.1) Release Note

= Properties > Material > Concrete

Material Data

General
Material I Name
Elasticity Data
) Steel
Type of Design Concrete e
Standard
DB
Concrete
Standard | IRC(RC) ~]
Type of Material Code
(®) Isotropic Orthotropic
DB | |v
Steel M15
M20
Modulus of Elasticity : 0.0000e+000 | kNfm~2 M35
M30
Poisson's Ratio i} M35
Thermal Coeffident : 0.0000e+000 | 1/[C]
Weight Density 0 kNfme3 mgtﬁl
Use Mass Density: 0 kifm~3fg M&0
M&S5
—|E|Concrehe m;‘g -
Modulus of Elasticity : 3.4312e+007 | kyjm~2 M0
i ! - M85
Poisson's Ratio 0.2 M20
Thermal Coeffident : 1.2000e-005 | 1/[c]
Weight Density 25 | kNfm~3
[ Use Mass Density: 2.549 | kjm~3fg

IRC:112-2011

Material Data o
General
Material I Name
Elasticity Data
) Steel
Type of Design Concrete A4
Standard
DB
Concrete
Standard | IRS(RC) ]
Type of Material Code
(®) Isotropic Orthotropic
DB |v
Steel M20
M25
Modulus of Elasticity : 0.0000e+000 | kNfm~2 M30
M35
Poisson's Ratio :
Thermal Coefficent : 0.0000e+000 | 1/[C] m;‘g
Weight Densi 0 kNfm*3 M35
g ty f MED
|Jse Mass Density: 0 | kMfm~3fg
—|E|Concrehe
Modulus of Elasticity : 3.1000e+007 | kfm~2
Poisson's Ratio 0.2
Thermal Coeffident : 1.1700e-005 | 1[c]
Weight Density 25 kNjm~3
[] Use Mass Density: 2.549 | knjm~3fg
IRS Concrete Bridge Code
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23. IRS Load Combination

Civil 2020 (v1.1) Release Note

- Load combination can now be auto-generated based on recommendations in IRS Concrete Bridge Code, including derailment loads

+ These load combination could be used for IRS PSC design

= Results > Load Combination

Autematic Generation of Load Combinations

Option
® Add ) Replace

Code Selection

Steel @ Concrete SRE Steel Composite

Design Code : IIRS vI

Manipulation of Construction Stage Load Case
C 5T only C cs only @ 5T+C5
ST : Static Load Case C5 : Construction Stage

Ultimate State Option
| Consider Creep, Shrinkage and Differential Temperature for
ULS Load Combination

Partial Safety Factor for Differential Settement
Ultmate State Service State I:I

Load Case for Derailment
Consider Derailment Loads

Load Combinations O
General I Steel Design  Concrete Design |SRC Design I Composite Steel Girder Design I
Load Combination List Load Cases and Factors
No | Name | Active Type E Description * LoadCase Factor | #
» 1 Strengt | Add [ |1U:D:SIDL:SM:EP:F 4 1.2500
2|clLCB2 |Strengt |Add [ | 1U:D:SIDL:SM:rEP: Bouyancy(ST) 2.0000
3|cLCB3 |[Strengt |Add [™ | 2U:D-SIDL:SM-W Dead DC(ST) 2.0000
4|cLCB4 |Strengt |Add [ | 2U:D:SIDL:SM:rW Dead DW(ST) 2.0000
5|cLCB5 |Strengt |Add [™ | 2U-D-SIDL-SM-W-FI Pavement(ST) 2.0000
6|cLCB6 |Strengt |Add [ | 2U:D:SIDL-SM:rW-F Ballast(ST) 2.0000
7|cLCBY |Strengt |Add [ | 2U:D:SIDL:1.6RS(X) Settlement(ST) 1.0000
§|cLCB8 |Strengt |Add [™ | 2U-D:SIDL:1.6RS(X) Earth Pressure(ST) 1.7000
9|cLCBY |[Strengt |Add [™ | 2U:D:SIDL:1 6RS(X) Horizontal EP(ST) 1.7000
10 cLCB10 |Strengt | Add [ | 2U:D:SIDL:1.6RS(X) Vertical EP(ST) 1.7000
11| cLCB11 | Strengt | Add [ | 2U:D:SIDL:-1.6RS(X Earth Surcharge(ST) 1.7000
12| cLCB12 | Strengt | Add [ | 2U:D:SIDL--1.6RS(X Ground Water Pressure(ST) 1.7000
13| cLCB13 |Strengt | Add [™ | 2U:D:SIDL--1.6RS(X LL Surcharge(ST) 1.7000
14 | cLCB14 | Strengt | Add [ | 2U:D:SIDL:-1.6RS{X FPLL{ST) 1.5000
15 cLCB15 |Strengt | Add [ |2U:D:SIDL:0 48RS Live Load(ST) 1.7500
16 cLCB16 |Strengt | Add [ |2U:D:SIDL-0 48RS Centrifugal(ST) 1.7500
17 | cLCB17 | Strengt | Add [ | 2U-D:SIDL:-0.48RS( Braking(ST) 1.7500
18| cLCB18 |Strengt | Add [ |2U:D:SIDL--0 48RS( SET(SM) 1.0000
19)cLCB19 |Strengt | Add [ |2U:D:SIDL:0 48RS MVLC(MV) 1.7500
20| cLCB20 | Strengt | Add [ | 2U:D:SIDL:0.4BRS( #
21|cLCB21 | Strengt | Add [ |2U:D:SIDL:-0 48RS( +
< > v
Copy Import... Auto Generation... Spread Sheet Form
File Name: | G:\Beta TestingIRS Load Combinations\Sample Model_in| Browse Make Load Combination Sheet Close

Load Combination dialogue box

Derailment Load Cases

Ultimate Limit State Serviceability Limit State
DeRail 1
DeRail 2
DeRail 3
-=
s

Cancel

MibAS
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24. Prestressed Concrete Design by IRS Concrete Bridge Code

- Prestressed concrete girder design by IRS Concrete Bridge Code is now available.

Civil 2020 (v1.1) Release Note

0420 MPa

= PSC > Design Parameter > Parameters > IRS
View Structure Mode/Element Properties Boundary Load Analysis Results Pushover
I I EPSC Design Material EPSC Segment Assignment g g EﬁesultTables -
E Parameters E Design/Cutput Position = E Exposure Class % Desigr 4.Torsional Resistance
E= seniceability Load Combination Type &3 Torsion & Interface Sh fertorm Dee EPSCR W Maximum Shear Force
erviceability Load Combination Type orsion & Interface Shear | pesign Report g 1 Design Load
S Load Combination Name :  ULS1
Design Situations :
PSC Design Parameters x Load Combination Type :
Nes = -18066.337 kN
Design Code : Veg = -244 386 kN
Tea = 293.826 kN -m
O Mes = 39746713 kN-m
Design Parameters (Ultimate limit states)
Moment resistance Prestressing Steel Type - Design strength of concrete
(® Consider tendons in tensile zone (O Consider all tendons (& Smooth bars and wires fe = ool e - 17.867 MPa
User Input Data | Modify design parameters... | O strands : _
- Design strength of Reinforcement
Construction Type fpa = [y / Ye_rebar = 434.783 MPa
() Segmental (®) Non-5egmental
2 Check Torsional Resistance
Output parameters B Closed Section Part
- Design P t
Ultimate limit states Serviceability limit states ssign Farameters
=TiH(2 “hwe - Ag) = 0.024 MPa
[ ultimate bending resistance Stress for cross section at a construction stage Where,
[~15hear resistance Stress for cross section at service loads Vi = Torsional Stress
) ) . ) T = Te
Torsmnal resistance Principal stress at a construction stage oo = wall thickness for torsion
[ Principal stress at service loads Ag = area enclosed by median wall line
Tensile stress for prestressing steel
Vimn = Minimum torsional resistance =
[ crack control R
Select Al Unselect All ve = Vib-d) = 0.039 MPa
Where,
Vis = Shear stress in section
Cancel V=g = 244386 kN
Input & Output parameters Excel Report

(RS 64.238)

(RS6.22)

(RS, 105.2)
(IRS CBC 15.4 4 4, Equation 9)

400.077 mm
15612913.33 mm?

(IRS CBC, Table 17)
Torsional R/F not required

(IRS CBC 1543 1, Equation &)
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